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Welcome and Introduction
Welcome to Microsoft Office 2007: What’s New in Word, PowerPoint, & Ou
look. This workshop introduces the primary changes in the 2007 Microsof
Office system user interface as well as new features in some of the comm
used Office applications.

What You Should Already Know
You should have already attended at least one Microsoft Office 2003 wor
shop or be familiar with Microsoft Word. Specifically, you should be able t

• perform commands from the Office 2003 Menu bar and toolbar
• switch between Office applications
• enter and edit text or data
• save and print a document

What You Will Learn
This workshop provides information about the dramatically new Microsoft
Office 2007 interface and some new file formats and compatibility issues. 
ticipants will explore:

• considerations when upgrading to Microsoft Office 2007
• the new Microsoft Office 2007 interface
• new features in Microsoft Word 2007
• new features in Microsoft PowerPoint 2007
• new features in Microsoft Outlook 2007

What You Will Need to Use These Materials
To complete this workshop successfully, you will be provided with:

• the use of Microsoft Office 2007
• the exercise files in the Office07 folder: Gardening.doc, and PPT.pptx
Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  1
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Getting Started
These materials presume you will begin work from the desktop, and have
required exercise files located in an epclass folder there. For instructions 
obtaining the exercise files, see below.

If you need assistance logging on or starting an application, please consu
your instructor.

Finding Help
If you have computer-related questions not answered in these materials, 
can look for the answers in the UITS Knowledge Base, located at:

http://kb.iu.edu/

Self-Study Training
Want to learn more on your own?  

IT Training Online makes self-study computer-based courses available on
wide range of IT topics.  You may also purchase STEPS workshop materia
use in learning on your own.  To find out more, go to:

http://ittraining.iu.edu/online/

Getting the Exercise Files
Most of our workshops use exercise files, listed at the bottom of page 1 o
materials. In our computer-equipped classrooms, these files are located i
epclass folder, which should already be on the computer desktop. If you a
using our materials in a different location, you may obtain the exercise file
from our Web site at:

http://ittraining.iu.edu/workshops/files/

Once you are logged on and have the needed files in an epclass folder on
desktop, you are ready to proceed with the rest of the workshop.
2 Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  
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Upgrading to Microsoft Office 2007
There are several Microsoft Office 2007 suites available for purchase. Th
Office Enterprise 2007 version is supported by Indiana University and is 
available for download from http://iuware.iu.edu/. Listed below are other ver-
sions available, along with the applications included:

Version Applications Included

Office Basic 
2007

Word 2007, Excel 2007, Outlook 2007

Office Standard 
2007

Word 2007, Excel 2007, PowerPoint 2007, 
Outlook 2007

Office Home 
and Student 
2007

Word 2007, Excel 2007, PowerPoint 2007, 
OneNote 2007

Office Small 
Business 2007

Word 2007, Excel 2007, PowerPoint 2007, 
Publisher 2007, Outlook 2007 with Business 
Contact Manager, Accounting Express 2007

Office Pro 2007 Word 2007, Excel 2007, PowerPoint 2007, Ac-
cess 2007, Outlook 2007 with Business Con-
tact Manager, Publisher 2007

Office Pro 2007 
Plus

Word 2007, Excel 2007, PowerPoint 2007, Ac-
cess 2007, Outlook 2007, Publisher 2007, In-
foPath 2007, Communicator 2007

Office Enter-
prise 2007
(new in 2007; 
available from 
iuware.iu.edu)

Word 2007, Excel 2007, PowerPoint 2007, 
Outlook 2007, Access 2007, Publisher 2007, 
Groove 2007, OneNote 2007, InfoPath 2007

Office Ultimate 
2007
(new in 2007)

Word 2007, Excel 2007, PowerPoint 2007, 
Outlook 2007 with Business Contact Manager, 
Access 2007, Publisher 2007, Groove 2007, 
OneNote 2007, InfoPath 2007, Accounting Ex-
press 2007
Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  3
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Listed below is a short description of some of the various applications con
tained in the Office Enterprise 2007 version:

• Publisher 2007 - a business publishing program that allows users to cre
design, and publish materials for print, email, and the Web.

• Groove 2007 - A secure tool which allows work groups to bring files and c
versations together in one place using a shared workspace.

• OneNote 2007 - Allows users to gather thoughts and ideas in electronic 
books; they can store and organize notes (typed, handwritten, or audio)
computer.

• InfoPath 2007 - Provides an easy way to create and manage information 
electronic forms.

For more information on the various applications available in the Microsof
Office 2007 suites, go to:

http://office.microsoft.com/en-us/suites/

Introduction to the Office Open XML Format
By default, documents created in Word 2007, Excel 2007, and PowerPoin
2007 are saved in the new Office Open XML format. Some benefits of us
the XML format include: 

• File size is reduced by use of compression technology.
• If a component within a file is damaged or corrupted, the file can still be

opened since files are structured in a modular fashion,
• XML file formats are freely available for anyone to use. Office documen

and data files can be easily integrated into other applications. 

The default file format for documents, workbooks, and presentations now
an “x” on the end, which represents the XML format. This also applies wh
saving templates. If a file contains code or macros, you must save the file
using the new macro-enabled file format, which has an “m” on the end. Fo
example, a Word document is saved with the .docx extension, a Word template
is saved with the .dotx extension, and a macro-enabled template is saved wi
.dotm extension.

NOTE: The new file format in Access 2007 has some different characteris
For more information on file formats in Access, consider taking the
workshop Microsoft Office 2007: What’s New in Access.

Converting Documents to Other File Formats
In previous versions of Microsoft Office, the Adobe Standard Suite was 
required to save a PDF. The 2007 Microsoft Office system offers a free ad
which allows users to save or export PDF (Portable Document Format) an
XPS (XML Paper Specification) files. 
4 Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  
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Both of these formats are fixed-layout electronic file formats that preserve
document formatting and enable file sharing. The PDF format is useful fo
documents that will be reproduced by using commercial printing methods
You can download the 2007 add-in “Microsoft Save as PDF or XPS,” from
Downloads page from Microsoft Office Online.

Why Upgrade to Microsoft Office 2007
With a little time and some practice, you will find that commands are read
available and easy to find. Microsoft has attempted to organize command
the core applications from left to right based on the stages of a document

An overview of the Microsoft Office 2007 features include:

Feature Description

Visual-oriented lay-
out

Commands are easy to find and not bur-
ied inside multiple menus.

Contextual command 
tabs

Tools are displayed when an object is se-
lected and available only when you need 
them.

Preserved shortcuts Keyboard shortcuts work as in previous 
versions

Customizable Quick 
Access Toolbar

Your favorite commands can always be 
visible in each of your applications.

Live Preview You can see the result of your choices 
before selecting them.

Feature consistency Certain tools, such as charting tools, are 
the same in each application.

Graphical capabilities SmartArt graphics are available to help 
you create diagrams from scratch or to 
convert bulleted items into appealing dia-
grams.

Document themes Many themes are available across multi-
ple applications to keep all of your docu-
ments looking consistent and 
professional.
Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  5
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Exploring the Office 2007 Interface
When you open any of the new Microsoft applications for the first time, yo
will find that they look very different. Some scaled-down task panes, such
the Styles task pane, will open automatically when you click a command t
help you complete a task. We will explore various aspects of the new Offi
2007 interface.

Let’s launch Microsoft Word and then explore the new interface.

1. Launch Microsoft Word. 

Some of the elements of the new Word interface are identified below:

NOTE: If your window is already maximized, your Ribbon icons may appe
somewhat differently from what you see here.

Command tabs

Quick Access
Toolbar

Microsoft
Office button Ribbon

Group
Dialog Box Launcher

View tools
6 Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  
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2. To maximize the window, in the upper right corner, if necessary,

™ 

Using the Microsoft Office Button
The Microsoft Office Button in the upper left corner has replaced the File 
menu that we used to see in older versions of Microsoft Office. We will se
the same basic commands available in earlier releases such as Open, Sa
Print; however, more commands are now available, including Prepare an
Publish.

Viewing Enhanced ScreenTips
Enhanced ScreenTips are larger windows that display more descriptive tex
than a regular ScreenTip and can have a link to a Help topic. They offer a
way to get contextual help that comes and goes without taking up a lot of r
on the screen. Regular ScreenTips display only the name of the tool at th
mouse pointer position, but Enhanced ScreenTips are used for those item
need a little more explanation. Enhanced ScreenTips also appear when p
tioning the pointer over the Dialog Box Launcher to enable users to get a q
preview to see if the dialog box is the one they want.

NOTE: Enhanced ScreenTips will also include relevant keyboard shortcu

1. To view an Enhanced ScreenTip,

§ to 

You should see:

NOTE: ScreenTips can be turned off by customizing the program in which
you are working. In Word, just ™ the Office button, and then 
™ the Word Options. In the dialog box, ™ Popular, and under 
Top options for working with Word, in the ScreenTip style list, ™ 
Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  7
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the appropriate setting that you want. Then close the dialog box a
save your settings. This procedure is very similar in all Office pro-
grams.

2. To open the Microsoft Office button,

™ 

The Office menu opens:

This menu consists of two panels. On the left, we see major file tasks;
the right, the appropriate task appears when you point to one of the co
mands on the left. Note also the location of the Word Options command in 
the bottom right of the dialog box. This Options command is always loca
here in all of the Office applications and enables us to set specific pre
ences for the application in which we are working (which is similar to t
Tools > Options dialog box in older versions of Office applications).

NOTE: If we open a document that is in an older file format, we would see
additional Convert command listed in the left pane, which would 
enable us to quickly convert the document to the newer default (20
format.

3. To close the Office button, press:

…

8 Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  
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Using the Ribbon
The primary replacement for menus and toolbars in Office 2007 is the Ribbon. 
The Ribbon is designed to help users quickly find the commands that are
needed to complete a task. Commands are organized in logical groups, w
are related and collected together under the command tabs. To reduce cl
some tabs are shown only when needed.

The Ribbon consists of command tabs, groups, and various commands th
extend across the top of the window:

Exploring Tabs and Commands
The menu system in Microsoft Office 2003 has been replaced with a serie
Command tabs that relate directly to the tasks we need to accomplish. The
tabs correspond directly to the stages of the process we’re likely to follow
we create a particular project in an Office application. The first command 
includes a set of core commands for the most important type of work. For
example, in Word, the principal task is writing. The primary commands on
first tab pertain to writing tasks, such as font formatting and styles.

A command is a button, a box to enter information, or a menu. Commands
each Office application are organized under each command tab accordin
how they are used. Depending upon the application, the commands will v
The command tabs correspond to the various tasks a user might perform
logical sequence and, therefore, are arranged for the user’s convenience

Each command tab may contain several groups that show related items 
together. For example, on the Home command tab, we see the command
are grouped together related to changing text font.

NOTE: If your screen is set to a low resolution or if a program window is t
small, a few groups on the Ribbon may display the group name o
not the commands of the group. If this is true, you will need to ™ 
on the arrow on the group button to display the commands.

Ribbon

Command tabsCommands

Group
Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  9
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Let’s explore the various command tabs.

1. To explore the various groups within each command tab,

™ any command tab

Here is a summary of the various tabs and their commands in Word:

Notice how the groups change according to the tab that is selected.

NOTE: If you move the mouse over the Ribbon, you can use the scroll bu
on the mouse to progress through the command tabs.

Command Tab Commands

Home Work with clipboard commands, change fonts, 
bullets, and numbering, control alignment, 
choose styles, and sort, find and replace text

Insert Insert cover pages, tables, pictures, clip art, 
SmartArt, shapes, charts, headers and footers, 
hyperlinks, WordArt, and text boxes

Page Layout Choose themes, page setup options, water-
marks, and page color and border backgrounds, 
control paragraph indents and spacing, and po-
sition objects

References Add table of contents, footnotes, citations and 
bibliographies, captions, index, and table of au-
thorities

Mailings Create envelopes and labels and perform a mail 
merge

Review Proof a document, add comments, track or ac-
cept and reject changes, and compare and pro-
tect documents

View Choose different document views, show/hide 
ruler, gridlines, and document map, magnify or 
reduce the display, arrange document windows, 
and record macros

Add-Ins This tab may appear if add-ins are installed and 
allowed to run on your computer, such as Adobe 
PDFMaker.
10 Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  
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2. To return to the Home command tab,

™ the Home command tab

Let’s see how we can minimize the Ribbon to maximize our workspac

Minimizing and Restoring the Ribbon
There is no way to delete or replace the Ribbon with toolbars or menus fr
earlier versions of Office. However, we can minimize the Ribbon to make
more space available on the screen. 

Let’s minimize the Ribbon by double-clicking the active command tab.

1. To minimize the Ribbon,

£ the Home command tab

The Ribbon is minimized.

2. To temporarily restore the Home command tab,

™ the Home command tab

Once we choose any command or ™ within the document, the Ribbon
goes back to being minimized. Let’s see how this works.

3. To minimize the Ribbon,

™ within the document

Notice that the Ribbon returns to the minimized state.

4. To restore the Ribbon to its original state,

£ the Home command tab

NOTE: To use the keyboard shortcut to minimize or restore the Ribbon, p
ƒ + F1. You can also £ any command tab to restore the Rib
bon.
Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  11
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Opening a Dialog Box
The small diagonal arrows in the lower-right corner of some groups are ca
Dialog Box Launchers as illustrated below:

By clicking this arrow, we will see a dialog box, which will look familiar from
an older version of the application. 

Let’s open a dialog box using the launcher arrow.

1. To open a dialog box, in the Paragraph group,

™ 

You should see the Paragraph dialog box:

Dialog Box Launcher
12 Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  
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Notice that the Paragraph dialog box looks very similar to the one we h
seen in Word 2003.

NOTE: The default spacing in Word 2007 is set to Multiple 1.15 and spac
after paragraphs is set to 10 pt. You can change this to the Word 2
default of single spacing and 0 spacing after paragraphs, To keep
these defaults, ™ the  button at the bottom of the dialog 
box and ™  when asked if you want your changes to affe
all new documents based on the Normal template.

2. To close the Paragraph dialog box,

™ 

Exploring Additional Tabs 
Certain tabs appear only when we need them, which keeps our workspac
uncluttered and relevant to the tasks at hand. These Contextual or on-demand 
tabs provide additional groups and commands for working with a selected
item. These tabs appear next to the standard set of tabs in an accent colo

We will insert a table so that we may view these additional tabs.

1. To view the Insert commands,

™ the Insert command tab

2. To access the Table drop-down menu, 

™ 

We see a Quick Table gallery, which allows us to select the required num
ber of rows and columns for the table.
Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  13
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3. To begin to insert the table,

§ to a 3x2 table

You will see: 

4. To create the table in the document,

™ the 3x2 table

A table appears in the document with three columns and two rows.

Additional tabs appear:

We see Table Tools, showing groups of commands for working with tab
When we are through working with the table, Table Tools, as well as t
Design and Layout contextual tabs, will disappear.

5. To deactivate Table Tools, in the body of the document,

™ below the table

If we want to work in the table again, all we have to do is to select the ta
and Table Tools will reappear allowing us to have quick access to the
propriate commands to format the table.

Using the Quick Access Toolbar
The Quick Access Toolbar is a customizable toolbar in the upper-left corner
which contains tools that we use frequently every day. We can add our fav
commands to this toolbar so that they are available regardless of which ta
have activated.

Table Tools

Contextual command tabs 
14 Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  
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The Quick Access Toolbar appears as follows:

We will move the Quick Access Toolbar to another location below the Ribb
and then add and remove a command button.

Moving the Quick Access Toolbar
If we don’t want the Quick Access Toolbar to be displayed above the Ribb
then we can move it to another location below the Ribbon. However, we m
decide to keep it in its default location above the Ribbon if we want to ma
mize the work area.

Let’s move the Quick Access Toolbar below the Ribbon.

1. To move the Quick Access Toolbar below the Ribbon,

™ , ™ Show Below the Ribbon

The Quick Access Toolbar is now located below the Ribbon.

2. To move this toolbar above the Ribbon to its default location,

™ , ™ Show Above the Ribbon

The Quick Access Toolbar is located above the Ribbon.

Customizing the Quick Access Toolbar
We will add a Quick Print command to the Quick Access Toolbar so that 
can send a document directly to the default printer without making chang

1. To open the Office button, in the upper-left corner,

™ 
Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  15
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2. To add the Quick Print command,

§ to Print, µ Quick Print, 

™ Add to Quick Access Toolbar

The Quick Print command is now added to the Quick Access Toolbar.

Next, we will see how easy it is to remove a command from the Quick 
cess Toolbar. This time we will use the Customize command in the W
Options dialog box.

3. To begin to remove the Quick Print command button,

™ , ™ 

4. To continue, in the left pane,

™ Customize

You should see this Word Options dialog box:

Notice that any command can be selected from the categories in the lef
of the Word Options dialog box and added to the Quick Access Toolb
Also, any command currently on the Quick Access Toolbar can be sele
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on the right side and removed from the toolbar. Notice also that comma
can be reordered on the Quick Access Toolbar by using the up and do
arrows.

5. To remove the Quick Print command, from the right side of the Word 
Options dialog box,

™ Quick Print, ™ 

NOTE: To remove a command, you can also µ the command on the 
Quick Access Toolbar and then ™ Remove from Quick Access 
Toolbar.

6. To close the Word Options dialog box,

™ 

The Quick Print command is no longer displayed on the Quick Access
Toolbar.

NOTE: Only commands can be added to the Quick Access Toolbar. The 
tents of most lists, such as individual fonts or specific theme color
cannot be added to this toolbar.

Accessing the Mini Toolbar
When text is selected with the mouse, a miniature, semitransparent toolb
called the Mini toolbar, appears. This Mini toolbar allows us to work with 
fonts, font styles, font sizing, alignment, text color, indent levels, and bulle
features. This is a very convenient feature, especially if the Ribbon is min
mized.

NOTE: This Mini toolbar cannot be customized.

Let’s see how this Mini toolbar appears when we select text with the mou

1. To enter text preceded by two blank lines, type:

© © Office 2007
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2. To display the Mini toolbar,

¢ the text 

NOTE: You can also • the text to select it.

We see a transparent toolbar, which appears to the right or left of the s
ed text, depending upon which direction we drag the mouse.

3. To access the Mini toolbar,

§ to the transparent toolbar

4. To make the text bold,

™ 

NOTE: If you move the mouse within the document or on the Ribbon, the
Mini toolbar disappears, and you will have to reselect the text to ge
back.

5. To deselect the text,

™ anywhere in the document

The text is now bold.

Using Live Preview
The Live Preview feature, included in several programs in Microsoft Office
2007, allows us to see how formatting options will look before we commit
them. By pointing to various formatting choices on the Ribbon, we can 
instantly see how the selected text or objects will appear.

1. To activate the Home tab, if necessary,

™ the Home tab
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2. To select the text in the document,

• the text

We will change the font color, but this time we will use the formatting too
on the Ribbon.

3. To format the text, in the Ribbon Font group,

™ ,§ to any color

Notice how the color of the text changes as you move the pointer over
ious font colors. This live preview feature does not work from the Mini
toolbar.

4. To select a color,

™ any color

The text color has been applied to the selected text.

NOTE: To cancel live previewing without applying any changes, press ….

5. Deselect the text.

Exploring the New View Controls
The Office 2007 release uses the View tab to organize the controls neede
viewing a document or switching between windows. Some of these tools u
to be in the Window menu in older versions of Microsoft Office.

The View tab on the Ribbon organizes the controls needed for viewing do
ments.
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1. To view the View controls,

™ the View tab

You see some familiar View controls:

NOTE: These tools will vary somewhat, depending upon the Office applic
tion being used.

The familiar Document View buttons and Zoom tools also appear on t
status bar in the lower-right corner of the document window:

To magnify or reduce the size of the document displayed on the screen
can drag the slider in the Zoom tool until the document is the size we w

Let’s experiment with a few of these View controls using the status ba

2. To show the document in full screen, on the Status bar,

™ 

3. To restore the document to Print Layout, press:

… 

4. To zoom in or out of the document,

¢ the Zoom slider tool to any percentage

We can also open the Zoom dialog box to choose a particular zoom se
We will change the setting to 100%.

Print Layout

Full Screen

Web Layout
Zoom

Outline

Draft
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5. To open the Zoom dialog box,

™ the zoom percentage in the status bar

The Zoom dialog box opens:

6. To change the zoom setting,

™ the 75% radio button ©

NOTE: To save a particular zoom setting with a document, you must mak
change in the document first. This change could be as simple as 
adding and deleting a single space.

Using KeyTips
KeyTips in Office 2007 enable us to display all the available shortcut keys 
choose the one we want. Every command in a Ribbon program can be 
accessed by using just a few keystrokes. All of the old shortcut keys that 
with ƒ, as well as the function keys, have been retained.

We will display the KeyTips by toggling on the display of keystrokes.

1. To switch to the Home command tab,

™ the Home command tab
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2. To display the KeyTips, press:

«

The KeyTips are displayed over each feature that is available in the cu
view.

3. To display the View tab, type:

w

The View tab is displayed, along with the KeyTips for the groups in that t
Depending upon which letter you press, additional KeyTips may appe

4. To zoom the document to 100% of the normal size, press:

j

NOTE: The KeyTips disappear once you select a command or ™ within 
the document. You can also press « to hide KeyTips.

Finding Help
Changes in the Office 2007 system are designed to give us better answe
our questions as quickly as possible. Each program in Microsoft Office ha
separate Help window, which means that we can view separate Help wind
when working in different applications. In addition, Microsoft Office main-
tains unique settings for each of these Help windows.

NOTE: If you have a slow Internet connection, you can “Show content on
from this computer” by clicking the Connection Status menu in the
bottom right corner of the Help window.

Let’s view a Help window in Microsoft Word.
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1. To open the Word Help window, in the upper-right corner,

™ 

NOTE: The Ê key also opens the Help window.

You see the Word Help window:

The Back, Forward, and Home buttons have been used in older versio
Microsoft Office. This Help window can be resized or moved just like a
other window. To search for a help topic, just type the text in the text b
and press ©.

Navigation tools
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The tools on the Navigation bar are described below:

2. To search for a help topic, in the Search box, type:

saving documents ©

We see results for “saving documents.”

3. To choose a Help topic,

™ any help link

4. To navigate the Word Help window,

experiment with the navigation tools

5. Close the Word Help window.

Tool Name Purpose

 Back Goes back to the previous Help topic.

 Forward Goes forward to a previous Help topic.

 Stop WIll stop Help from searching.

 
Refresh Updates content in the Help window.

 Home Returns to the Home default contents 
within the current application.

 Print Prints the current window.

 Change Font 
Size

Changes the size of text in the Help win-
dow.

 Show Table 
of Contents

Provides a lists of Help topics in the left 
pane related to the application you are 
working in.

 Keep on Top This new “push pin” tool will allow you to 
keep the Help window on top of the Office 
programs; it has no effect on applications 
that are not Office applications.
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6. To close the document without saving,

™ , ™ Close, ™ 

What’s New in Word 2007
The Ribbon in Office 2007 provides a simpler way for users to find and us
the tools they need to produce high-quality documents. We have seen ho
new Ribbon groups tools by task, which are further broken into subtasks,
how the command buttons in each group carry out a command or display
menu of commands.

Since we have already explored the new look and feel of the Microsoft Of
program window and user interface, we will continue by focusing on some
important new features of Microsoft Word.

Opening an Older Version of a Word Document
Let’s begin by opening a Word document that has been saved in a previo
version of Word.

1. To begin to open an existing file,

™ , ™ Open

You see the Open dialog box. Since the exercise files are located in a
folder in the epclass folder on the desktop, we will locate the file.

2. To move to the desktop,

™ 

The Look in field is now set to the Desktop.
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3. To open the epclass folder,

£ 

The epclass folder contents are now visible. We will open the Office07 sub-
folder.

4. To open the Office07 subfolder,

£ the Office07 subfolder

5. To open the correct file,

£ Gardening.doc

The file opens. Since the file was saved in an older version of Word, the
bar displays the words [Compatibility Mode].

NOTE: To open a Word 2007 file in Word 2003, you will need to downloa
the Office 2007 Compatibility Pack for Office 2003. This Compatibil-
ity Pack is available for download from either of the following Web
sites:

http://iuware.iu.edu/

http://www.microsoft.com/downloads/

Understanding Compatibility Issues
When Compatibility Mode is turned on, this ensures that no new or enhanc
features in Word 2007 are available while users are working with a docum
since older versions of Word do not understand some of the new features
Word 2007. You can either work in Compatibility Mode, or you can convert
save your document in the Word 2007 format. In order to take advantage o
new features in Word 2007 and the reduced file size, you will want to save
document in the Word 2007 format. 

Some considerations when saving Word documents that were created in 
ous versions are:
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• To save the file in the original format, choose Save. The Word file will retain 
its original format.

• To save a file in the 2007 format, choose Save As and choose the default file
format (.docx). The older file format will then remain intact. You will also 
have the option to maintain compatibility with an older version of the ap
cation, which will prevent you from using any 2007 features that are not c
patible with older versions of Word.

• To replace the file with the newer 2007 format, convert the file and then 
choose Save. Unless you choose Save As and specify a different filename, 
converting and saving a file will replace the old file format with the defau
2007 format.

We will convert this document to a Word 2007 document.

1. To convert a document to Word 2007,

™ , ™ Convert

You will see:

2. To continue and replace the document with the converted version,

™ 

Notice that this document is no longer in Compatibility Mode. Next we w
save the document in the 2007 default format.

3. To save the Word document in the Word 2007 file format, on the Quic
Access Toolbar,

™ 

The file has been converted and saved in the Word 2007 file format. T
extension in the title bar now displays the *.docx file extension.

NOTE: To preserve a document in its 97-2003 format and create another
ument in the Word 2007 file format, ™ the Microsoft Office But-
ton, and ™ Save As. Then type a name for the file.
Microsoft Office 2007: What’s New in Word, PowerPoint, & Outlook v1.1.0  27



iar 
 

acro-
en-

e-
pply-
 
e 
 we 

ont, 
yle.
Understanding Different Word File Formats
By default, documents that are created in Office 2007 are saved in XML 
format with new file name extensions that add an “x” or an “m” to the famil
filename extensions. The “x” signifies an XML file without macros, and the
“m” signifies an XML file that does contain macros.

The following table lists all of the default file formats in Word 2007.

NOTE: A 2007 Word document containing a macro must be saved as a m
enabled document and cannot be renamed with a different file ext
sion.

Applying a Quick Styles Set
Office Word 2007 includes a new Quick Styles set feature that enables the pr
viewing of a number of predesigned style sets before selecting one and a
ing it to a document. The colors and formats work together for the various
heading levels, body text, quotes, and titles in a single document. Once w
have selected a Quick Style set that is appropriate for the document, then
can apply individual styles from the Styles gallery.

We can also create or customize our own styles by formatting text in the f
style, and color we want, and then by saving our formatting as a Quick St

Let’s apply a Quick Style set to our document.

1. To activate the Home tab, if necessary,

™ the Home tab

XML File Type Extension

Document .docx

Macro-enabled document .docm

Template .dotx

Macro-enabled template .dotm
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2. To begin to apply a Quick Style set, in the Styles group on the Ribbon

™ , § to Style Set, 

§ to any style set

Notice that the Live Preview feature shows us what the text will look li
before we actually choose a style set.

3. To select a Quick Style,

™ Modern

The headings and body text reflect the new Quick Style set.

NOTE: The Quick Style set will not modify the heading styles that have b
previously applied to the document. For example, if headings hav
Heading 1 style applied to them, the Quick Style set will also appl
Heading 1 style.

4. To save changes to the document, press:

ƒ s

Choosing Document Themes
Styles allow us to change certain parts of a document, whereas Document 
themes allow us to change the way text, tables, graphics, and special elem
are displayed throughout the entire document. It is now very simple to cho
color and style options with one click of the mouse rather than separately
choosing from various format options. Since all of the content is linked to 
theme, if a theme is changed, then a complete set of new colors, fonts, a
effects is instantly applied to the entire document. Microsoft Word, Excel, 
PowerPoint provide several predefined themes, but we can also create ou
by customizing an existing document theme and then by saving it as a cu
document theme. Document themes are shared across Office programs i
order to maintain a consistent look in all Office documents.

Since we have applied styles, we will see how predefined themes affect a
styles in our document.
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1. To access the Page Layout controls, 

™ the Page Layout command tab

2. To choose the Themes command, in the Themes group,

™ 

The Themes gallery opens, displaying a number of different theme opt

3. To view a theme,

§ to any theme

The changes appear in the document window.

4. To select a theme,

™ Concourse

The document reflects the new theme.

NOTE: Document themes immediately affect the styles that you have use
your Word document. You can make further modifications by custo
izing theme colors, fonts, or theme effects.

Using SmartArt Graphics
SmartArt graphics provide a way for users to create sophisticated diagram
quickly and easily. With SmartArt graphics, users can create organization
charts, data processes, cycles, relationships, and more. SmartArt graphic
available in Word 2007, Excel 2007, PowerPoint 2007, and in Outlook 20

There are several types of graphics, such as: list, process, cycle, hierarch
relationship, matrix, and pyramid. It is best to limit the number of shapes a
amount of text to key points; however, some layouts work better with larg
amounts of text than others.

We will insert a list into the “Buying Plants” section of our document showi
the various things to keep in mind when buying plants.
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1. To place the cursor in the document,

™ in the blank line at the end of the Buying Plants section

We will first center the cursor using a keyboard shortcut.

2. To turn on the center feature using the shortcut key, press:

ƒ e

NOTE: You can also press the Center command under the Home comma
tab.

The cursor is centered.

3. To access the SmartArt command, on the Ribbon,

™ the Insert tab

4. To choose the SmartArt command, in the Illustrations group,

™ 

The Choose a SmartArt Graphic dialog box opens:

This window is divided into three panes. Once you have chosen a cate
in the left pane, the middle pane gives multiple options for that particu
category. Then the far right pane shows a preview of the graphic that 
been selected.
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5. To choose the List type, in the left pane,

™ List

6. To explore the various List layouts, in the middle pane,

™ any layout

7. To select a List layout, at the end of the first row,

™ , ™ 

The Text pane is ready for us to enter new text:

We can enter text either in the Text pane or in the graphic itself. We will 
the Text pane, which can give us a little more control over text levels, 

NOTE: If the Text pane did not appear, ™  to the left of the graphic to 
open the Text pane.

Notice that when we select a layout, the colors match the theme of our
ument. In addition, even though placeholder text is displayed, it will not
printed. However, the shapes are always displayed and printed, unles
delete them. Some layouts contain a fixed number of shapes and cann
changed to display more concepts.

We will replace the placeholder text with our own text, and then we will
size the graphic. 

8. To enter text, type:

Avoid plants with wilted leaves

NOTE: Depending upon the theme selected, the text may resize to fit the
placeholders.
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9. To select the second text placeholder, press:

‰

NOTE: If you press ©, a new text placeholder will be added.

10. To enter text, type:

Avoid plants already in bloom

11. To select the third text placeholder, press:

‰

12. To enter text, type:

Look for signs of disease and bugs

13. To close the Text pane, in the upper right corner,

™ 

Finally, we will resize the graphic.
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14. To resize the graphic,

§ to the upper right corner of the graphic until the double-
sided arrow appears

¢ down until the graphic is resized appropriately

You should see something like this:

NOTE: With the graphic selected, you can use the contextual Design tabs
change the layout and customize colors, animation, effects, and m
To learn more about SmartArt graphics, refer to Word Online Help

15. Deselect the graphic.

Using Enhanced Writing Tools
Microsoft Word 2007 has added some new and enhanced features to ma
writing easier and more efficient. We will explore a few of these features.

Displaying Live Word Count
Microsoft Word’s 2007 live Word Count tool makes it easy to keep track of 
the number of words in your document as you are writing. The word coun
appears naturally, by default, in the lower-left corner of the Word 2007 sta
bar. You can also display a word count for a particular selection of text jus
selecting the text.

The page number and word count display in the status bar:
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1. To view the number of pages, characters, paragraphs, and lines, in th
status bar,

™ the word count

NOTE: You can also open the Word Count dialog box by clicking  located 
in the Review tab on the Ribbon.

You will see the Word Count dialog box:

Some statistics are displayed for this Word document. Notice that we 
also include text boxes, footnotes, and endnotes by selecting a check

2. To close the Word Count dialog box,

™ 

We can also take a quick look at our document stats and customize th
tus bar.

3. To get a quick report of the different elements that are enabled in the s
bar,

µ the status bar

A pop-up menu appears and shows the status of various items and fea
We can show or hide any of the display controls by clicking them.

4. To close the Customize Status Bar pop-up menu, press: 

…
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Customizing Proofing Options
The spelling checker is now more consistent across the 2007 Office syste
programs. Several spelling checker options are global so that if one optio
changed in the Office program, then that option is also changed for all of 
other Office programs. Users can add words to exclusion dictionaries, wh
will flag words that the user wants to avoid using. Also, spelling and gramm
options can be disabled for a single document or for all documents that ar
ated.

The new improved Office spelling checker can now offer suggestions in W
Outlook, and PowerPoint by using the contextual spelling option. For exa
ple, if you typed “their” instead of “there,” the spelling checker flags the m
take and offers a suggestion when you µ the flagged word.

The proofing options in Word 2007 will allow us to change spelling correct
options that affect all Office programs, change the spelling and grammar 
checking options for Outlook and Word, select AutoCorrect options, and u
the contextual spelling option.

Next we will enable the contextual spelling option.

1. To open the Office button,

™ 

You should see:
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2. To open the Word Options dialog box,

™ 

We will verify that the appropriate checkboxes are selected to perform 
textual spell checking.

3. To display the Proofing options, in the left pane,

™ Proofing

4. Verify that these settings look as follows:

Now the spelling checker will flag the contextual spelling errors.

We will reset the spelling and grammar checker so that Word will rech
words and grammar that may have been previously checked.

5. To reset the spelling and grammar checker,

™ 

A dialog box appears telling us that this operation will reset the spellin
checker and grammar checker so that Word will recheck words and g
mar we previously chose to ignore. This will allow us to see the flagge
contextual spelling errors.

6. To continue,

™ 
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7. To close the Word Options dialog box,

™ 

NOTE: Using contextual spelling on a system with low memory can cause
slow performance. After you install Microsoft Office, if your system
has less than one gigabyte (GB) of RAM, the “Use contextual spe
ing” checkbox is cleared by default.

Using the Spelling Checker
The contextual spelling errors are flagged in a blue color to distinguish the
from regular spelling and grammar errors.

1. To view the Proofing commands, on the Ribbon,

™ the Review tab

2. To move to the beginning of the document, press:

ƒ á

3. To begin the Spelling & Grammar check, in the Proofing group,

™ 

NOTE: Another alternative is to µ each individual error that is flagged 
and view the suggestions.

The cursor stops at the incorrect word “too.”

4. To correct the first error and accept the suggestion of “to,”

™ 

The cursor stops at the incorrect word “their.”
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5. To correct the second error and accept the suggestion of “there,”

™ 

The cursor stops at the word “hoe.” Since this word is correct, we will 
nore this suggested error.

6. To continue,

™ 

A dialog box appears telling us that the spelling and grammar check is 
plete.

7. To complete the spell check,

™  

8. Save the document.

Working with Building Blocks
Office 2007 introduces building blocks (templates) for adding preformatted 
content to your documents. You can select from a gallery of preformatted
cover pages, pull quotes, page numbers, headers and footers, and more,
single click. You can also add your own reusable building blocks, for exam
ple, a custom header or footer, to a gallery that is available in Word 2007

Now that our document is complete, we will add a cover page to our final 
ument.

1. To move to the Insert command tab,

™ the Insert command tab

2. To choose a professional-looking cover page, in the Pages group,

™ 

We see a gallery displaying various cover pages.
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3. To choose a cover page,

™ Sideline

The cover page appears with a similar theme that has been applied to
rest of the document. The title of the document is automatically placed
the cover page. Depending upon the cover page selected, there may b
placeholders for a subtitle, company, author, abstract, and/or date.

NOTE: If you decide to choose a different cover page, it will replace the o
you originally selected. To cancel the gallery without selecting a co
page, press ….

4. Save the document.

Let’s save this document in an earlier version of Microsoft Word and vi
the Compatibility Checker.

Saving a Word 2007 Document in an Earlier Format
Before we close Microsoft Word, we will save this document in Word 97-
2003. Word uses the Compatibility Checker to show us what features wer
used that are not supported in earlier versions.

1. To begin to save the document, in an earlier format of Word,

™ , § Save As 

2. To begin to save a copy of the document so that is compatible with W
97-2003,

™ Word 97-2003 Document

The document extension in the “save as type” field is automatically se
*.doc. 

3. To name the document, in the File name box, type:

Backup Gardening
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4. To complete the save,

™ 

The Word Compatibility Checker dialog box appears:

Notice that a summary lists some features that are not supported by e
versions of Word. The title page will be converted to static content, and
SmartArt graphics will be converted to a single object, which can only
edited using the Picture toolbar.

5. To accept the warning,

™ 

We now have the document saved in an older format of Microsoft Word
well as the new 2007 format.

6. Close Microsoft Word.

What’s New in PowerPoint 2007
PowerPoint 2007 shares the new user interface and many of the new fea
of the 2007 Microsoft Office system. The command tabs on the Ribbon co
spond to the usual sequence of steps in creating a PowerPoint presentat
Office PowerPoint 2007 offers new and improved themes, effects, and 
enhanced formatting options that can be used in creating dynamic and pr
sional presentations quickly and easily.
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Understanding New PowerPoint File Types
The same rules of saving and converting files in Word 2007 also apply in P
erPoint 2007. You can still save a PowerPoint 2007 presentation in the Po
Point 97-2003 format for those users working with older versions of 
PowerPoint.

The following table lists the file types and extensions available in PowerP
2007:

NOTE: PowerPoint 97-2003 does not recognize the new SmartArt graphi
and other visual objects, such as charts and equations, that are a
able in PowerPoint 2007; they will be converted to bitmaps to mai
tain their appearance.

To open a PowerPoint 2007 file in PowerPoint 2003, you will need to dow
load the Office 2007 Compatibility Pack for Office 2003. This Compatibility 
Pack is available for download from either of the following Web sites:

http://iuware.iu.edu/

http://www.microsoft.com/downloads/

XML File Type Extension

Presentation .pptx

Macro-enabled presentation .pptm

Template .potx

Macro-enabled template .potm

Macro-enabled add-in .ppam

Show .ppsx

Macro-enabled show .ppsm

Slide .sldx

Macro-enabled slide .sldm

Office theme .thmx
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Beginning a New Presentation
The same themes that are available in Word 2007 can be applied to Pow
Point presentations, which can make all of our presentations look consist
All content links to the theme; therefore, if we change themes, a complete
of colors, fonts, and effects is applied to our entire PowerPoint document

Let’s view the various choices as we begin a new presentation.

1. Launch Microsoft PowerPoint.

2. To begin a new presentation.

™ , ™ New

The New Presentation window opens:

There are several available theme and template options in the left pane
ery document that we create in PowerPoint 2007 has a theme applied
(even blank documents). A template is a special document (for example, 
photo album is a template) with special content, layout, formatting, an
styles; templates contain formatting based upon a particular theme. W
we select a particular template or a theme, it will show up in the Recently 
Used Templates category in the New Presentation dialog box if we shou
want to reuse it later.

We will use a blank template and apply a special theme to it.
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3. To choose a theme,

™ Installed Themes, ™ any theme

The preview pane in the right pane gives you a preview of what the th
will look like. Notice that titles in some of the themes are preset to app
in all caps.

4. To accept the theme,

™ 

The first slide is a Title slide with title and subtitle placeholders. The co
theme that we selected will affect the background, text, tables, and ob
so that they will match a consistent and cohesive set of colors.

NOTE: The Themes gallery in the Design tab will allow you to choose a d
ferent theme or to customize your own themes for later reuse. Do
ment themes may be applied to all slides, to selected slides, or to
master slide.

Saving the File
The saving process is basically the same as in Word 2007. When we sav
PowerPoint 2007 file, we can either save it in an older format of PowerPoin
in the default format (*pptx). 

Let’s save this file in the default 2007 format.

1. To save the file, in the upper left corner of the Quick Access Toolbar,

™ 

2. To change the location to the epclass folder,

™ 

3. To open the epclass folder,

£ 
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4. The epclass folder opens. 

Next we will open the Office07 subfolder.

5. To open the Office07 subfolder,

£ the Office07 subfolder

The new PowerPoint extension .pptx is shown as the type of file being 
saved.

6. To name and save the PowerPoint file, in the File name box,

¢ the text, type: 07_PPT ©

The file is saved as a PowerPoint 2007 file, as indicated in the title ba

Exploring Command Tabs
Let’s explore the various command tabs.

1. To explore the various groups within each command tab,

™ any command tab

Here is a summary of the various tabs and their commands in PowerP

Command Tab Commands

Home Work with clipboard commands, add a new 
slide or new layout, change fonts, bullets, and 
numbering, control alignment, convert to 
SmartArt graphics, insert and arrange shapes, 
and find and replace text

Insert Insert tables, pictures, clip art, SmartArt, 
shapes, charts, headers and footers, hyper-
links, WordArt, text boxes, and media clips

Design Choose page setup options, themes, colors 
and fonts, background styles, and hide back-
ground graphics

Animations Create animations and transitions and ad-
vance slides automatically
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Notice how the groups change according to the tab that is selected.

2. To return to the Home command tab,

™ the Home command tab

Changing a Slide Layout
Microsoft PowerPoint 2007 includes built-in standard layouts for each the
which are similar to those available in PowerPoint 2003. We can also cus
ize our own layout if none of the standard layouts meet our needs.

We will see how easy it is to change the Title and Content slide to a Title O
slide.

1. To modify the slide layout, in the Slides group,

™ 

Several built-in layouts are displayed.

NOTE: You can also µ the slide and § to Layout. The same layout 
gallery will appear. Then you can ™ the appropriate layout slide.

2. To choose a layout,

™ the Title Only layout

The slide has a title placeholder.

Slide Show View a slide show, set up a slide show, and 
choose screen resolution

Review Proof a document, add comments, and protect 
a presentation

View Choose different presentation views, create 
and edit slide masters, show/hide ruler or grid-
lines, magnify or reduce the display, arrange 
windows, and record macros

Add-Ins This tab may appear if add-ins are installed 
and allowed to run on your computer, such as 
Adobe PDFMaker.

Command Tab Commands
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A Note About Customizing Slide Layouts
An important change in PowerPoint 2007 allows you to customize slide 
master layouts by inserting placeholders. You can create and add your ow
custom layouts with as many placeholders as you want, which can then b
saved as templates. The placeholders can include many different types o
objects, such as graphics, tables and charts. The Insert Placeholder com
becomes available when you select the Slide Master command in the Vie
tab.

Working with Slides
We will add some text to the first slide.

1. To begin to enter a title, 

™ in the title placeholder

2. To enter a title, type:

PowerPoint 2007

3. To deselect the placeholder,

™ outside the placeholder

Inserting Slides from Another Presentation
We will insert some existing slides from another presentation. Once the s
are imported, we can apply various colors and effects.

1. Verify that slide 1 is selected.

2. To begin inserting slides, in the Slides group,

™ , ™ Reuse Slides...

A task pane appears. We will browse to select the file that has the exis
slides.
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3. To insert slides from an existing presentation, in the task pane,

™ , ™ Browse File...

The Browse dialog box opens.

4. Navigate to the Office07 folder.

5. To open the file,

£ PPT.pptx

Three slides appear in the task pane. We can view each thumbnail. N
that as we § to a slide, the text enlarges so we can see what is on e
slide.

NOTE: If you want to keep the source formatting when inserting slides, ™ 
the “Keep source formatting” checkbox at the bottom of the task pa

6. To insert all slides, in the task pane,

µ any slide, ™ Insert All Slides

The slides are inserted into our current presentation after the selected 
Notice that the slides are formatted according to the theme we selecte

7. Close the task pane.

Modifying WordArt Text
We can use WordArt to make visual enhancements to text that go beyond
changing a font style or font size. WordArt now gives us more choices to 
stretch words horizontally, vertically, or diagonally.

Let’s modify the WordArt on slide 3.

1. To switch to slide 3, in the left pane with the slides tab,

™ slide 3

NOTE: This pane with the Slides and Outline tabs can be minimized or 
expanded by pressing and dragging the right border of the pane.
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2. To select the WordArt text,

™ the WordArt, ¢ the WordArt text

The WordArt text is selected, and the Drawing Tools are activated.

3. To activate the Format contextual tab,

™ the Format contextual tab

4. To change to a different WordArt style, in the WordArt Styles group,

™ 

A gallery of various WordArt styles is displayed.

5. To preview a WordArt style,

§ to any WordArt style

6. To select a WordArt style,

™ any WordArt style

A different WordArt style has been applied. 

Next we will apply a fill to the interior of the letters in the WordArt text.

7. To preview the text fill gallery,

™ 

A gallery of various text fills is displayed.
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8. To apply a text fill,

™ any text fill

A different text fill has been applied. 

Next we will apply an outline to the exterior border around each text c
acter of the WordArt.

9. To preview the text outline gallery,

™ 

A gallery of various outlines is displayed.

10. To apply a text outline,

™ any text outline

A different text outline has been applied.

Next we will apply a different effect to the WordArt text.

11. To preview the gallery of various types of text effects,

™ 

12. To apply a 3-D Rotation effect, in the drop-down gallery,

§ to 3-D Rotation, ™ any 3-D Rotation

A different 3-D rotation effect has been applied.

13. Deselect the WordArt.

NOTE: There are also various fills, outlines, and effects to choose from in
Shape Styles group that will affect the background and borders of
WordArt object.
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Converting Text to SmartArt Graphics
Text on a slide can easily be converted to SmartArt graphics that gives a 
visual representation of the information. Bulleted lists work very well in the
types of SmartArt graphic conversions.

Let’s convert the bulleted text on slide 2 to SmartArt graphics.

1. Verify that the Home command tab is selected.

2. Select slide 2.

First we will convert a bulleted list to SmartArt graphics.

3. To select the bulleted list, on slide 2,

™ the bulleted list

4. To convert the text to a SmartArt graphic, in the Paragraph group,

™ 

NOTE: Another alternative is to µ the bulleted text and § to Convert 
to SmartArt. The SmartArt graphic gallery opens, and you can ™ 
whichever graphic you want to use. However, when using this 
method, live preview doesn’t allow you to see the final result.

5. To view the various SmartArt graphics,

§ to any graphic

The live preview feature allows us to preview the final result.

6. To choose a graphic,

™ any graphic

The bullets have been converted into a SmartArt graphic.

NOTE: If you decide to convert the graphic to text and Undo is unavailabl
reverse the conversion, you can copy and paste the text from the 
pane into a new slide.

7. Deselect the graphic placeholder.
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Customizing Themes
A built-in theme can be customized with various colors, fonts, and effects
which can then be saved as a new theme in the theme gallery. These are
ally galleries of Quick Styles that always match the theme of your docume
Different background styles are also available. Themes and Quick Styles 
been created by visual designers to make sure that documents always loo
fessional. Additional themes can also be downloaded from Microsoft Offic
Online. 

We will change the theme of the presentation.

1. Switch to the Design command tab.

2. To select a different theme, on the Ribbon in the Themes group,

™ any theme

NOTE: Quick Styles (located on the Home command tab) may be applied
selected text or to individual objects on a slide.

Applying Theme Colors
PowerPoint 2007 provides a large palette of color groups that helps take 
guesswork out of trying to choose the right color combinations. The color 
group that is chosen from the Colors gallery is then applied to the theme th
associated with particular slides.

Theme colors have 12 color slots, which represent text and background, 
accent, and hyperlink colors for a particular theme. Theme colors handle 
light and dark backgrounds. Visibility rules are built into the theme so that
colors can be switched at any time to make the content legible and attrac

Let’s apply a different color scheme to the slide presentation.

1. To choose a different color scheme, in the Themes group,

™ , ™ any color scheme

The color scheme updates the theme used in all of the slides. When y
§ to , a ScreenTip will display the name of the current them
colors that have been applied to the theme.

NOTE: To apply a different theme or a color scheme to selected slides on
µ any theme in the themes gallery or any color scheme in the 
color gallery and select “Apply to Selected Slides.”
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Adding Transitions and Animations
PowerPoint 2007 gives us many different visual effects to choose from th
can be applied to text, objects, shapes, graphics, and charts. It also inclu
many different types of slide transitions and animations, which can be ea
previewed by pointing to a sample thumbnail on the Ribbon. We will explo
some different transition and animation effects.

Applying Transition Effects
Slide transitions occur in Slide Show view as you move from one slide to 
another. We can control the speed of each transition effect and add sound
along with the transition.

Let’s look at some different types of slide transitions in PowerPoint 2007.

1. Verify that slide 2 is selected.

2. To see the transition effects, 

™ the Animations tab

3. To preview a transition effect, in the Transition to This Slide group,

§ to any slide thumbnail

We see a brief preview of the transition.

4. To view the entire gallery,

™ 

5. To choose a transition,

™ any transition effect

The transition is applied to the selected slide. 

An icon appears under the slide number in the Slides pane. If you ™ on 
this icon, you will see a preview of the transition.
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6. To apply the transition to all slides, on the Ribbon,

™ 

The transition has been applied to all slides in the presentation.

Applying Animations to SmartArt Graphics
We can add animations to text, graphics, or practically any shape or obje
a slide. The animations that are available for SmartArt graphics depend o
layout that is chosen for the SmartArt graphic. We can add an animation to
entire SmartArt graphic or to an individual shape within the graphic.

1. Verify that slide 2 is still selected.

2. To select the SmartArt graphic,

™ the SmartArt Graphic

3. To view the preset animations, in the Animations group,

™ 

We have the option to apply the animation as one object or one by one
will apply the animation so that each object will come in separately.

4. To apply the animation one by one, in one of the available categories,

™ One by one

Each part of the graphic enters the slide individually. 

Next we will apply an animation to slide 4.

5. Deselect the graphic placeholder.

6. To advance to slide 4, press:

‰ ‰
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7. To select the SmartArt graphic on slide 4,

™ the SmartArt graphic

8. To apply an animation,

™ 

™ any animation

9. Save the presentation.

NOTE: Slide animations may be customized in many different ways. For m
information on applying animations to SmartArt graphics, see the 
Microsoft PowerPoint Online Help.

Viewing the Presentation
We will view the presentation.

1. To switch to the Slide Show command tab, on the Ribbon,

™ the Slide Show command tab

2. To preview the slide show, beginning from the first slide,

™ 

3. To move through the complete slide show,

™ the mouse button several times

NOTE: The custom animation had previously been set for the WordArt on
slide 3.

4. Close Microsoft PowerPoint.
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What’s New in Outlook 2007
Microsoft Outlook 2007 has a new look but has not changed as drastically
some of the other Office applications. Many features have been improved
help organize and share information with other individuals.

To-Do Bar and Navigation Pane
Tasks are displayed in three locations in Outlook 2007: in tasks, in the Ca
dar, and in the To-Do Bar. The new To-Do Bar at the right side of the window
gives you a consolidated view of daily priorities. It will also include tasks fro
OneNote 2007 or Project 2007. The To-Do bar can be turned on or off, or
can be minimized.

The Outlook window looks something like this:

To-Do
Bar

Navigation
pane

Inbox
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When the To-Do Bar is expanded, it shows all “to-do” events within the cu
rent week:

The To-Do Bar consists of the Date Navigator, the Appointments section,
the Task List. Each part can be turned on or off by right-clicking the To-D
Bar title bar and checking the appropriate option. By default, three appoin
ments are shown. Increasing the appointments or number of months disp
is also an option in the To-Do Bar Options dialog box.

You can now collapse the navigation pane in Office Outlook 2007 when y
want to give yourself more room to work on-screen. Your favorite folders a
icons for primary views are available in the collapsed bar so that you can
tinue to select those views as needed. To collapse the navigation pane, ™ 
the left arrows at the top of the pane.

Outlook Message Editor
Outlook 2007 no longer gives you the option of using Microsoft Word as y
Email editor to edit or read messages. However, you have the option of c
posing a new or reply message in Outlook in plain text, rich text, or HTML
format. The default editor is a Word-like editor that crosses the old Outloo
editor capabilities with Word-like features.
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The Message window looks like this:

Instant Search
With Instant Search, you can quickly locate information in your email, cale
dar, contacts, or tasks. Just enter a keyword, and Instant Search quickly 
searches your Outlook 2007 data; it will even search for keywords with em
attachments.

Attachment Previewer
You can now preview attachments from within the Reading pane by maki
only a single click. Therefore, you can view attachments in context with th
email message.

Unified Messaging
Microsoft Exchange Server 2007 and Office Outlook 2007 are now integra
and you have the advantage of being able to receive voice mails and faxe
your inbox. 

Calendaring Features
New color categories are now combined with the labels features. The sam
color category can be added to mail, calendar, or task items so that you c
locate all items from a particular project quickly.

Message
Window

Office button Quick Access toolbar
Ribbon
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When viewing another person’s calendar in Outlook 2007, you can view ei
side-by-side or in overlay mode (using tabs). This allows you to view appo
ments on both (or all) calendars at the same time.

You can now send your calendar to anyone in an email message or share
calendar with designated people by publishing your Internet calendar to O
Online or to any WebDAV server such as Oncourse.

Wrapping Up
We’ve reached the end of today’s workshop. Please follow your workshop
instructor’s guidance and take a few moments to fill out the workshop eva
tion form.

Also, before leaving, please log off your computer.

Thank you for participating in

Microsoft Office 2007: What’s New in Word, PowerPoint, &

Outlook 
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Where to Go From Here
You can use the resources listed below to further build your computing skills.

Taking Other IT Training & Education Workshops
UITS IT Training & Education offers hands-on instructor-led computing 
workshops aimed at a variety of skill levels, covering a broad range of topics. 
We teach hundreds of workshops on more than 80 topics every year! For more 
information, to see a detailed workshop schedule, or to register for a work-
shop, contact IT Training & Education:

Web: http://ittraining.iu.edu/ 
Email: (IUB) ittraining@indiana.edu; (IUPUI) ittraining@iupui.edu
Phone: (IUB) 812/855-7383; (IUPUI) 317/274-7383

Getting Help from Online Resources
University Information Technology Services – IU technology resources, 
services and support:
http://uits.iu.edu/

IT Training Online – Self-paced IT courses you can take on your computer:
http://ittraining.iu.edu/online/

UITS Knowledge Base – Searchable database of computing questions:
http://kb.iu.edu/

Getting Help from Support Staff
Walk-in Support

(All IU Campuses) Walk-in Support Center. Locations and schedules at:
http://kb.iu.edu/data/abxl.html

(IUB & IUPUI) Consultants in the UITS Student Technology Centers

24 Hour Phone Support

(IUB) 812/855-6789
(IUPUI) 317/274-4357

E-mail Support

(All IU campuses) ithelp@iu.edu
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